Chapter 157

Tests for the Odds Ratio in a Matched Case-Control Design with a Quantitative X

Introduction

This procedure calculates the power and sample size necessary in a matched case-control study designed to detect a relationship between the occurrence of a disease and a quantitative risk factor (exposure variable) using an odds ratio computed from a conditional logistic regression. The procedure also provides an adjustment to power for other covariates. Kleinbaum and Klein (2010) provide a detailed discussion of the interpreting the odds ratio in a conditional logistic regression.

Suppose a subject population is to be studied for the relationship between an outcome variable (such as lung cancer) and a quantitative risk factor (such as amount of cigarette smoking). A matched case-control study is planned in which \( N \) matched sets will used. Each matched set will consist of \( M_D \) case subjects which are positive for the outcome (diseased) and \( M_H \) control subjects that are negative for the outcome (healthy). The subjects in each set are matched according other covariates that are assumed to have a large impact on the probability of the disease such as age and gender. In each matched set a quantitative exposure variable is measured. Note that the design may be retrospective or prospective.

Technical Details

Hypotheses are investigated using a score test of the log odds ratio in a conditional logistic regression. Power and sample size formulas are given in Lachin (2008) and Tang (2009).

It is assumed that a set of \( N \) matched sets of cases and controls are available. Suppose a quantitative exposure variable \( X \) (the covariate) is measured for each subject. The data can be fit using conditional logistic regression. This is will result in regression coefficients for \( X \) and for any other independent variables included in the model. The regression coefficient of \( X \) is interpreted as the log odds ratio of a positive outcome for two values of \( X \) with a difference equal to one.

This relationship may be written in terms of \( OR \) as

\[
OR = \exp(\beta_X X)
\]
The regression coefficient, log(OR), is tested using a normally distributed score test. The power of the score test is calculated using

\[ z_{1-\beta} = |\theta| \sqrt{N\sigma_X^2 \left( \frac{M_D M_H}{M_D + M_H} \right)} - z_{1-\alpha} \]

where \( \sigma_X^2 \) is the variance of the X values.

This can be rearranged to obtain the following expression for sample size

\[ N = \frac{(z_{1-\beta} + z_{1-\alpha})^2}{\sigma_X^2 \theta^2 \left( \frac{M_D M_H}{M_D + M_H} \right)} \]

Note that for two-sided tests, \( \alpha \) is replaced by \( \alpha/2 \).

Adjusting for Other Covariates

Lachin (2008) provides an adjustment to the power when additional covariates are fit in the conditional logistic regression. Let \( R^2_{X|Z} \) represent the coefficient of determination for a (multiple) regression of the exposure variable X on the covariates Z. Note that Z is a vector of 1 or more covariates and that the number of covariates is not needed. The adjustment is made by multiplying \( \sigma_X^2 \) by \( 1 - R^2_{X|Z} \) in the formulas above. Lachin stresses that in order for this adjustment to be accurate, none of the adjusting covariates can have a strong effect upon the response. He indicates that this assumption should be meet since any covariate with a large effect should be controlled for by the matching.

Procedure Options

This section describes the options that are specific to this procedure. These are located on the Design tab. For more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab

The Design tab contains most of the parameters and options that you will be concerned with.

Solve For

Solve For

This option specifies the parameter to be solved for from the other parameters. Select Sample Size when you want to calculate the Sample Size needed to achieve a given power and alpha level.

Select Power when you want to calculate the power of an experiment that has already been run.
**Test**

**Alternative Hypothesis**
Specify whether the alternative hypothesis of the test is one-sided or two-sided. If a one-sided test is chosen, the hypothesis test direction is chosen based on whether OR is greater than or less than one.

**Two-Sided Hypothesis Test**
H0: OR = 1 vs. Ha: OR ≠ 1

**One-Sided Hypothesis Tests**
Upper: H0: OR ≤ 1 vs. Ha: OR > 1
Lower: H0: OR ≥ 1 vs. Ha: OR < 1

---

**Power and Alpha**

**Power**
This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis, and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null hypothesis is not rejected.

Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now, 0.90 (Beta = 0.10) is also commonly used.

A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be entered.

**Alpha**
Alpha is the probability of rejecting a true null hypothesis. The null hypothesis is that the odds ratio (OR) is 1. This means that the probability of a positive outcome is no different for those that have been exposed to the risk factor and those that have not.

Values must be between zero and one. Historically, the value of 0.05 has been used for alpha. This means that about one test in twenty will falsely reject the null hypothesis. You should pick a value for alpha that represents the risk of a type-I error you are willing to take in your experimental situation.

A single value may be entered here or a range of values such as 0.05 to 0.2 by 0.05 may be entered.

---

**Sample Size**

**N (Number of Sets or Strata)**
N is the number of matched sets in the study. Each set consists of Md cases and Mn controls. The total number of subjects is N x (Md + Mn).

The range of possible values is of 3 or more. Multiple values may be entered.

**Md (Number of Cases per Set)**
The number of case subjects in each of the N matched sets. The cases are those subjects with a positive outcome, such as diseased. Thus, the total number of subjects is N x (Md + Mn).

Values of one or greater are allowed. Seldom is this value chosen to be more than five.
Multiple values may be entered.
M (Number of Controls per Set)
The number of control subjects in each of the N matched sets. The controls are those subjects with a negative outcome, such as healthy (non-diseased). The total number of subjects is N x (M₀ + M₁).
Values of one or greater are allowed. Seldom is this value chosen to be more than ten.
Multiple values may be entered.

Effect Size

OR (Odds Ratio | 1-Unit Change in X)
The value of the odds ratio to be detected. This is the odds ratio at which the power is calculated. Note that the power or sample size will be identical for 1/OR and OR.
The odds ratio is the ratio of the odds at X = x + 1 to the odds at X = x. The logarithm of the odds ratio is used in the formula. Log (OR) is equal to the regression coefficient of the quantitative covariate X in the conditional logistic regression.
For example, an odds ratio of 2.0 means that subjects for which the covariate value is x+1 have twice the odds of having the disease as do subjects for which the covariate value is x.
A value greater than one is usually used. The value must be greater than zero. The null hypothesis is that the odds ratio is one.
You can enter a single value such as 1.5, a list of values such as 1.5 2.0 2.5, or a series of values such as 1.5 to 2.5 by 0.01.

σₓ (Standard Deviation of X)
Enter an estimate of the standard deviation of X, the quantitative variable of interest. Note that as σₓ increases, the sample size decreases. If you don’t have an estimate, you can select the Standard Deviation Estimator from the Tools menu to obtain a window that will help you determine a rough estimate of the standard deviation.
The range of this parameter is greater than zero.
You can enter a single value such as 1.0, a list of values such as 1.1 1.3 1.5, or a series of values such as 1 to 3 by 0.5.

R² (Exposure vs. Covariates)
Enter the R² value that would be obtained if the X variable was regressed on the other covariates (independent variables) to be used in the conditional logistic model. This is referring to the R² from a regular multiple regression of X on the covariates.
This R² value is used to calculate an adjustment to the power and sample size when the covariates are in the model. Note that the number of covariates is not used in the adjustment and so it is not entered.
If you do not have any covariates, enter ‘0.0’.
The absolute range is from zero to just less than one. However, it is assumed that covariates with large impacts will be used in the matching process.
You can enter a single value such as 0.1, a list of values such as 0.05 0.1 0.2, or a range of values such as 0.0 to 0.1 by 0.01.
Example 1 – Calculating Sample Size

This example will show how to calculate the power of a two-sided, retrospective study for several sample sizes and odds ratios.

Suppose that a matched case-control study is to be run in which the OR = 1.5, 2.0, 2.5, or 3.0, \( \sigma_x = 1.3 \), \( R^2 = 0.2 \), \( M_D = 1 \), \( M_H = 1, 2, \) or 5, power = 0.9, and alpha = 0.05, and power is to be found.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Tests for the Odds Ratio in a Matched Case-Control Design with a Quantitative X procedure window. You may then make the appropriate entries as listed below, or open Example 1 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td></td>
</tr>
<tr>
<td>Solve For</td>
<td>Sample Size N</td>
</tr>
<tr>
<td>Alternative Hypothesis</td>
<td>Two-Sided</td>
</tr>
<tr>
<td>Power</td>
<td>0.9</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.05</td>
</tr>
<tr>
<td>( M_D ) (Number of Cases per Set)</td>
<td>1</td>
</tr>
<tr>
<td>( M_H ) (Number of Controls per Case)</td>
<td>1 2 5</td>
</tr>
<tr>
<td>OR (Odds Ratio)</td>
<td>1.5 2 2.5 3</td>
</tr>
<tr>
<td>( \sigma_x ) (Standard Deviation of X)</td>
<td>1.3</td>
</tr>
<tr>
<td>( R^2 ) (Exposure vs. Covariates)</td>
<td>0.2</td>
</tr>
</tbody>
</table>

Annotated Output

Click the Calculate button to perform the calculations and generate the following output.

Numeric Results

<table>
<thead>
<tr>
<th>Power</th>
<th>Number of Matched Sets ( N )</th>
<th>Cases per Set ( M_D )</th>
<th>Controls per Set ( M_H )</th>
<th>Odds Ratio OR</th>
<th>Standard Deviation of the Covariate ( \sigma_x )</th>
<th>Regression of X on other Covariates ( R^2 )</th>
<th>Alpha</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.9014</td>
<td>95</td>
<td>1</td>
<td>1</td>
<td>1.5000</td>
<td>1.3000</td>
<td>0.2000</td>
<td>0.0500</td>
</tr>
<tr>
<td>0.9004</td>
<td>71</td>
<td>1</td>
<td>2</td>
<td>1.5000</td>
<td>1.3000</td>
<td>0.2000</td>
<td>0.0500</td>
</tr>
<tr>
<td>0.9014</td>
<td>57</td>
<td>1</td>
<td>5</td>
<td>1.5000</td>
<td>1.3000</td>
<td>0.2000</td>
<td>0.0500</td>
</tr>
<tr>
<td>0.9056</td>
<td>33</td>
<td>1</td>
<td>1</td>
<td>2.0000</td>
<td>1.3000</td>
<td>0.2000</td>
<td>0.2000</td>
</tr>
<tr>
<td>0.9083</td>
<td>25</td>
<td>1</td>
<td>2</td>
<td>2.0000</td>
<td>1.3000</td>
<td>0.2000</td>
<td>0.0500</td>
</tr>
<tr>
<td>0.9083</td>
<td>20</td>
<td>1</td>
<td>5</td>
<td>2.0000</td>
<td>1.3000</td>
<td>0.2000</td>
<td>0.0500</td>
</tr>
<tr>
<td>0.9072</td>
<td>19</td>
<td>1</td>
<td>1</td>
<td>2.5000</td>
<td>1.3000</td>
<td>0.2000</td>
<td>0.0500</td>
</tr>
<tr>
<td>0.9023</td>
<td>14</td>
<td>1</td>
<td>2</td>
<td>2.5000</td>
<td>1.3000</td>
<td>0.2000</td>
<td>0.0500</td>
</tr>
<tr>
<td>0.9206</td>
<td>12</td>
<td>1</td>
<td>5</td>
<td>2.5000</td>
<td>1.3000</td>
<td>0.2000</td>
<td>0.0500</td>
</tr>
<tr>
<td>0.9027</td>
<td>13</td>
<td>1</td>
<td>1</td>
<td>3.0000</td>
<td>1.3000</td>
<td>0.2000</td>
<td>0.0500</td>
</tr>
<tr>
<td>0.9096</td>
<td>10</td>
<td>1</td>
<td>2</td>
<td>3.0000</td>
<td>1.3000</td>
<td>0.2000</td>
<td>0.0500</td>
</tr>
<tr>
<td>0.9096</td>
<td>8</td>
<td>1</td>
<td>5</td>
<td>3.0000</td>
<td>1.3000</td>
<td>0.2000</td>
<td>0.0500</td>
</tr>
</tbody>
</table>
**References**

Lachin, John M. 2008. ‘Sample size evaluation for a multiply matched case-control study using the score test from a conditional logistic (discrete Cox PH) regression model.’ Statistics in Medicine, Volume 27, Pages 2509-2523.


Tang, Yongqiang. 2009. ‘Comments on “Sample size evaluation for multiply matched case-control study using the score test from a conditional logistic (discrete Cox PH) regression model.”’ Statistics in Medicine, Volume 28, Pages 175-177.

**Report Definitions**

Power is the probability of rejecting a false null hypothesis.

- Number of Matched Sets, $N$, is the number of sets (strata) in the study. Each set consists in a fixed number of cases and controls.

- Cases per Set, $M_0$, is the number cases in each matched set.

- Controls per Set, $M_n$, is the number of controls in each matched set.

- Odds Ratio, $OR$, is the ratio of the odds of a positive outcome when the covariate is $X + 1$ to the odds of a positive outcome when the covariate is $X$.

- Standard Deviation of the Covariate $X$, $\sigma_X$, is the average SD of $X$ across all subjects in the study.

- Regression of $X$ on other Covariates, $R^2$, is the $R^2$ that occurs when the covariate variable of interest $X$ is regressed on any other covariates. This adjustment assumes that covariates that have a large correlation with the outcome are used in the matching process and are not included here.

- $\alpha$ is the probability of rejecting a true null hypothesis of no association between disease and the exposure variable.

**Summary Statements**

In a matched case-control study, a sample of 95 matched sets (or strata) is obtained. Each matched set consists of 1 case and 1 control. The standard deviation of $X$ is 1.3000. This sample achieves 90% power to detect an odds ratio of 1.5000 calculated using conditional logistic regression with a 0.0500 significance level.

This report shows the power for each of the scenarios.

**Plots Section**

This plot shows the sample size versus the odds ratio for the three $M_n$’s.
Example 2 – Validation using Lachin (2011)

This example will validate this procedure by comparing the results to those in Lachin (2011) on page 351. In this example, \( \text{OR} = 1.4, \text{\( \sigma \text{\_x} \)} = 1, \text{\( R^2 \)} = 0.0, \text{\( M_D \)} = 1, \text{\( M_H \)} = 2, \text{\( \text{power} \)} = 0.85, \text{\( \text{alpha} \)} = 0.05. The test is two-sided. The resulting sample size is 119.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Tests for the Odds Ratio in a Matched Case-Control Design with a Quantitative X procedure window. You may then make the appropriate entries as listed below, or open Example 1 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td></td>
</tr>
<tr>
<td>Solve For</td>
<td>Sample Size N</td>
</tr>
<tr>
<td>Alternative Hypothesis</td>
<td>Two-Sided</td>
</tr>
<tr>
<td>Power</td>
<td>0.85</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.05</td>
</tr>
<tr>
<td>( M_D ) (Number of Cases per Set)</td>
<td>1</td>
</tr>
<tr>
<td>( M_H ) (Number of Controls per Case)</td>
<td>2</td>
</tr>
<tr>
<td>( \text{OR} ) (Odds Ratio)</td>
<td>1.4</td>
</tr>
<tr>
<td>( \text{( \sigma \text{_x} )} ) (Standard Deviation of X)</td>
<td>1.0</td>
</tr>
<tr>
<td>( \text{( R^2 )} ) (Exposure vs. Covariates)</td>
<td>0.0</td>
</tr>
</tbody>
</table>

Output

Click the Calculate button to perform the calculations and generate the following output.

Numeric Results

<table>
<thead>
<tr>
<th>Number of Matched Sets</th>
<th>Cases per Set</th>
<th>Controls per Set</th>
<th>Odds Ratio</th>
<th>Standard Deviation of the Covariate X</th>
<th>Regression of X on other Covariates</th>
<th>Power</th>
<th>Alpha</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power</td>
<td>0.8501</td>
<td>1</td>
<td>2</td>
<td>1.4000</td>
<td>0.0000</td>
<td></td>
<td>0.0500</td>
</tr>
</tbody>
</table>

PASS has also calculated \( N \) to be 119.